FREE!

The Best of MacWorld FAQs

Over 35 Pages Packed With FAQs!

Answers to the Most Frequently Asked Questions

Based on the ultimate answer book by Macworld columnist David Pogue!

Get 15% Off The Complete Book With Special Offer Inside!*
*Offer good through Dec. 96.
The Best of Macworld Mac FAQs

by David Pogue

IDG Books Worldwide, Inc.
An International Data Group Company

Foster City, CA • Chicago, IL • Indianapolis, IN
Braintree, MA • Dallas, TX
Introduction

What’s FAQ?
It stands for Frequently Asked Questions.
I didn’t make this up, by the way. The term FAQ is a by-product of the Internet explosion, when millions of first-time modem owners began to cruise that great worldwide bulletin-board. To keep from having to answer the same questions over and over again, veteran Internauts would type up all the obvious questions with patient, beautifully explained answers. Each one- or two-page file of Q’s and A’s was called, of course, a FAQ sheet. FAQ sheets started springing up faster than Boston Chicken outlets.

Of course, I run a great risk calling this book Mac FAQs. I mean, FAQ isn’t as well-known a 90’s term as, say, O.J. or infomercial. At this very moment, somebody’s in a bookstore somewhere asking for a book called Mac Facts, or Mac Fax, or Max Factor.

But millions of people have the same questions about the Mac. Trouble is, there’s no central place to go for the answers. Macworld Mac FAQs, the real book, contains the 500 most frequently asked Mac questions on earth; the booklet you’re now reading contains a tempting assortment of 50 such questions.

Oh yeah — and the answers.

David Pogue
About the Author

David Pogue graduated summa cum laude from Yale in 1985. After spending six years conducting and arranging Broadway musicals, he began writing “The Desktop Critic” column for Macworld magazine; teaching the Mac to such celebs as Mia Farrow, Gary Oldman, Stephen Sondheim, and Carly Simon; and authoring books like Macs for Dummies, which has been the #1 bestselling Macintosh book for four straight years. (A sequel, More Macs for Dummies, debuted in 1994. And for people whose thirst for Mac wisdom remains unslaked, Pogue also co-wrote the encyclopedic, 1100-page Macworld Mac & Power Mac SECRETS, now in its 3rd Edition; it comes with, among 45 other programs, the complete Now Utilities.)

His first novel, a techno-thriller called Hard Drive, was called “a notable book of the year” by the New York Times; a new thriller is in the works.

David is a regular panelist at the Macworld Expo and user-group gatherings nationwide. He’s been profiled on “48 Hours,” in the New York Times, and in USA Today.

About the Book

The real, actual 420-page book, Macworld Mac FAQs, contains over 500 frequently asked questions — gorgeously organized and expertly answered. It includes dozens of the World’s Dumbest Tech-Support Call stories (like the handful in this booklet), a master list of keystroke shortcuts in all the popular programs, a list of phone numbers for all major software companies, and enough funny, interesting information to keep your eyebrows permanently raised.

If it’s not at your local bookstore, they’ll be happy to order it for you. Or save money by using the coupon at the end of this booklet.
Chapter 1: First-Timer FAQs

How can I avoid losing files?

A. Always click the Desktop button before you save.

Suppose you've just written a letter in ClarisWorks. When you choose Save for the first time, click the Desktop button before you click Save (see Figure 1).

Then, when you quit ClarisWorks at the end of the day, the new file you made will be sitting right there in front of you (see Figure 2). Now it's a simple matter to drag it into an appropriate folder. Do this regularly, and you'll never lose another file.

Incidentally: if you use a Performa or System 7.5, you can automatically avoid losing things. Turn on your "Save new documents into the Documents folder" option in the Performa or General Controls control panel, and all new documents will go straight into your desktop Documents folder.

Is it better to turn my Mac off every night?

A. Only for convenience or conscience; not to protect your equipment.

Some engineers maintain that the heat of leaving the Mac on all the time weakens the components, shortening their life. The others argue that the daily surge of electricity — from switching the machine on — is far worse.

There's an economic argument, too. Turning the Mac off at night saves hundreds of dollars' worth of electricity per year — and is better for the
environment. (The "sleep mode" of recent Power Mac models protects the screen and hard drive by letting them rest — but don't be fooled; sleep mode doesn't conserve electricity.)

The answer, then, is to do whatever's most convenient. Handy compromise: turn off the monitor at night. (It's perfectly OK for the computer to be on while the screen is off.) That way you don't have to wait for start-up the next morning; no surge of power goes through the machine every day; a major power consumer is off; and your monitor's phosphor coating lasts longer.

**Should I get a Mac now, or wait for the next model?**

A. Buy it now, unless Apple's coming out with a new model next week.

Face it: *any* computer is going to lose half its value and fall technologically behind-the-times in six months. The cycle *never* ends. This bit about ever-faster and ever-cheaper computers isn't specific to Mac, by the way. You'd fight the same technological dragon if you were an IBM-compatible fan. Therefore, the answer is: buy the Mac now. In the time you would have waited for the next great thing to come along, you'll use it, have fun, and get a lot done.

On the other hand, you don't want to be dumb about it. Check to see if Apple's coming out with something newer and better soon. **Way 1:** Ask the people at a computer store. It's free, but not totally trustworthy; these guys are often fairly clueless about Macs. **Way 2:** If your newspaper is metropolitan enough to carry computer ads, watch the Mac prices as the weeks go by. When a certain model's price suddenly tumbles, it's because a new model is about to replace it. **Way 3:** Sign onto Macworld Online (http://www.macworld.com) or America Online (keyword: macworld) and leave a question in the message area: "I want to buy a __. Is now a good time?" You'll get a good answer within a day. Or visit the MacWeek site on the World Wide Web; it's a magazine specializing in leaks from Apple.

**It says "Not enough memory." Should I throw some stuff away?**

A. Nope — that won't help.

If you throw away files you don't need anymore, you'll make more disk space. But you won't affect your computer's memory at all. (Memory is a fast, electronic, temporary kind of storage that gets used up when you launch one of your programs — and restored to availability only when you Quit a program. A disk, such as your hard drive, is where stuff is safely stored even when the computer is off.)
How can I get rid of the half-inch black border on my monitor?

A. You can't.

Using the little knobs tucked somewhere on your monitor, you can make the picture fill more of the glass. But you won't get more desktop area (that shows, for example, more of a page at a time); instead, you'll only be enlarging the picture that's there. See Figure 3.

What you have now. What you want (more viewing area). What you can get (same viewing area, larger dots.)

Figure 3: You can blow up your picture, but you won't see any more.

Monitor companies say that if they made the picture fill the glass edge-to-edge, the picture would be distorted around the edges. (They also want to boost their sales of bigger monitors.)

What do the different controls on a window do?

A. They're at the corners and edges of every Macintosh window. Here's a summary (see Figure 4).

Click to make the window go away. Drag to move the entire window. Click to see what folders this one's inside of. Click to enlarge the window (to show as much as possible.)

Click a label heading to change how the items are listed (biggest first, for example).

Drag this box to move vertically through the window contents. Drag diagonally to resize the window.

Click repeatedly (or hold down button) to scroll through the window contents.

Figure 4: The various ways you can push, pull, or tug a window.
The controls you’ll probably use the most often are the title bar (lets you move the window), the zoom box (upper-right, which expands the window as large as necessary to see its contents), and the close box (upper-left, which closes the window).

**I ejected a disk, but the Mac keeps asking for it back!**

A. And it always will, too, if you keep using the Eject Disk command.

Do not use the Eject Disk command (in the Special menu) to eject a disk. If you do, the disk’s ghostly image remains on the screen — even after you eject the disk. And the Mac stubbornly asks you to re-insert the disk before it lets you proceed with your regularly scheduled life. Instead, highlight the disk and choose Put Away from the File menu. That pops the disk out.

Alternatively, you can drag the floppy-disk’s icon to the Trash. You might feel as though you’re about to erase the disk, but actually the disk pops right out.

---

**FAQ: Rarely Asked Questions**

**Why does time begin on 1/1/1904?**

There are several ways to find out that the Mac believes history began on January 1, 1904. You could try setting your Mac's clock as far back as possible. You could undergo a really awful system malfunction; when it’s repaired, and your Mac is working again, its clock is likely to say January 1, 1904.

So why that year, of all things?

The original designers of the Mac chose that date for several reasons. First, in programmery terms, a longword (a piece of data 32 bits long — a handy size) has enough digits to specify about 130 years' worth of seconds. Second, they wanted to make sure that most Mac users' birthdays could be included; they figured 1904 was early enough. (That's too bad for my grandfather, who was born in 1890 and likes the Mac quite a bit.) Finally, they chose 1904 because it was arithmetically convenient — it was a leap year. (1900 wasn't a leap year because it was a century year.)

If you've got your calculator handy, you'll realize that the Mac's ability to recognize times will founder in the year 2030, on the Mac's 46th anniversary. At that point, the clock will reset itself to 1/1/04 again, and you'll have to buy yourself a new computer.

Still, you're a lot better off than your friends with IBM compatibles. Their computers will self-destruct, date-wise, in the year 2000; such machines can't handle the concept, and will have to be reprogrammed.
Chapter 2: How to Do It

**FAQ #8**

*How do I connect my StyleWriter, my QuickCam, and a modem all to the same jack?*

A. Get a manual switch box for $25, or an automatic one for several hundred dollars.

Several different kinds of Mac gear all are supposed to be plugged into your modem jack: the modem, MIDI synthesizers, label printers, the StyleWriter, and so on. What's a Mac fan to do?

The simplest and least expensive solution is to buy a manual A/B switch box from one of the Mac mail-order places. You can even get an A/B/C/D switch if you have a lot of gear. Just turn the knob (or punch a button) on the box to specify which gadget you want to use.

If you can't stand manually switching devices, you can buy a NuBus card that provides additional modem jacks. Or, you can get something called the Port Juggler, an external box with four modem ports. It's supposed to switch the Mac's attention from one to another automatically, depending on which program you're using. (A significant number of people can't get it to work, but other people report good luck. Buy it from a place that accepts returns.)

**FAQ #9**

*How do I make symbols, like € and ¥ and ©?*

A. Let Key Caps be your guide.

There it is, right in your Apple menu: the desk accessory called Key Caps. Open it. If you hold down your Option key, you'll see the complete map showing where all those useful symbols are hidden. By lifting your finger off the Option key as you stare at the symbol you wanted, you can figure out what normal letter key to type to produce it (when the Option key is down).

Don't forget, too, that each *font* may have different symbols. Change fonts using the Key Caps menu, which appears when Key Caps is open.

And if it's too hard to remember that Command-Shift-Option-Caps Lock-7 produces some desperately needed Swahili diacritical marking, *click* the onscreen symbol when you see it. It appears in the text strip at the top of the Key Caps window, where you can select it, copy it, and *paste* it into whatever document you're working on.

**FAQ #10**

*How do I connect the Mac to a TV or VCR?*

A. With a $250 adapter.

Mac models with the letters AV in their names, as well as certain Macs (such as the 8500, or the 630 or 5200 series with the optional Apple TV
card), can hook directly to a TV or VCR. All you need is a male-to-male RCA cable (which probably came with your Mac) for your VCR’s Video In jack.

All other models require an adapter, known as an NTSC converter. Any mail-order place will sell you one; the LTV Portable (Focus Enhancements) is one of the best known.

This NTSC converter plugs into your Mac’s monitor jack. (Of course, if your Mac doesn’t have a monitor jack, such as the PowerBook 150 or the SE/30, you’re out of luck.) Another wire goes to the VCR or TV, and a third gets plugged into a wall power socket. Your regular Mac monitor just sits there, gathering dust — unless you happen to have purchased one of the “Pro” converters, which have an extra jack for your monitor.

None of these methods make your Mac’s image look as good on TV as it does on its regular monitor. Don’t forget that TV was invented over 50 years ago; the quality of the newer technology blows away the feeble offerings of a television.

Still, a TV is a handy (and common) large-screen appliance. For people making presentations on the road or using the Mac in a classroom, getting the Mac on TV might just be the ticket.

**How do I take a picture of the screen?**

**A. Press Command-Shift-3.**

You’ll hear a satisfying camera-shutter sound. After a moment of frozen-cursor syndrome, you’ll find a new file called Picture 1 on your hard drive. (If you take more snapshots, they’ll be called Picture 2, Picture 3, and so on.) Double-click the Picture file to open it in TeachText or SimpleText. At this point, you can do two things:

1. Be confused. Be very confused. The menus and icons you’re seeing now aren’t real icons and menus — they’re just a picture of them, in PICT graphics format. Resist the temptation to pull down these menus.

Figure 5: Viewing a Picture 1 file (a screen shot) in SimpleText can be disorienting. You’re looking at a picture of the desktop, not the real desktop. In this screen shot, the Trash can on the right is the real Trash — and the menus at the very top are the real menus.
2. By dragging your cursor across the image and then choosing Copy from the Edit menu, you can grab a selected portion of the image and paste it into a word-processing document. (Incidentally, this is pretty much how I illustrated this book.)

MAQ: Mind-Blowingly Asked Questions

What makes a PowerBook slosh?

(A true story from a London computer technician. For your enjoyment.)

In December 1993, a customer walked in with a dead PowerBook 165. Problem description: hangs on startup. An additional symptom: while being carried from the customer’s site to our service center, customer says he heard a sloshing noise within the machine.

"Has anything been spilled on this computer?" I inquired. No, no, nothing of the sort, protested the client. Taking this with a grain of salt, I went about filling in the repair order.

On the workbench, I started the PowerBook. Sure enough: an address error on startup, just after "Welcome to Macintosh." I lowered my ear to the keyboard, at which point I heard a crackling noise and became aware of a rather sharp odor that seemed to emanate from the inside of the machine. Flicking the computer off, I removed the battery from its compartment, only to observe that the entire battery casing was soaked in fluid. I also noticed that the same clear fluid was leaking out of the battery compartment onto my anti-static mat.

My first thoughts were that the battery had somehow leaked acid, which would account for the sharp smell (which reminded me of ammonia) — yet the battery terminals were dry.

Tipping the machine on its side, I watched more fluid run out onto the bench in a puddle about the size of a compact disc. I then unscrewed the computer and separated the two parts of the PowerBook.

The smell suddenly became a lot stronger. The hard disk looked like a solid lump of rust. I invited several of my workmates in to take a sniff and offer an opinion. We were unanimous in our decision. I called the customer, who seemed surprised when I asked: "Do you have a cat?"

As it turned out, he didn't have a cat, but he did have a lovely fluffy bunny rabbit, who had been seen in the vicinity of the PowerBook only the day before. Yes, there was no doubt about it, little Fluffy had hopped up onto the keyboard and downloaded some incompatible data.

I checked the warranty form, but there was no provision for failure due to rabbit urine anywhere. I advised the customer to get in touch with his insurance company.

In the end, the PowerBook was unrepairable, and the customer upgraded to a 180c. I cleaned up the static mat and sprayed the service department with a healthy dosage of "Fresh Field of Flowers." I checked in with the customer a week later, asked how he was enjoying the 180c, asked if he'd managed to restore his data. And, of course, I asked how his rabbit was.

"Delicious," he said.
How can I put a picture on my desktop?
A. You need After Dark or Decor.

After Dark (version 3 or later) is best known as a screen saver. But its WallZapper feature lets you turn any PICT (graphics) file into a backdrop (Figure 6). For the first time, After Dark does something while you’re using your Mac.

Figure 6: Banish that boring desktop pattern forever! All you give up is about a meg of memory (for a full-screen photo).

In the After Dark control panel, click Setup, click WallZapper, click Set Picture, and choose the graphics file you want to use as a backdrop.

Connectix Desktop Utilities and the shareware program Decor can perform the same trick.

How do I get a cool sound to play when I turn on the Mac?
A. Drop it into your System folder’s Startup Items folder.

Any sound file you put there gets played when you turn on the Mac. If you put several files there, they’ll play in alphabetical order. This only works, by the way, with standard double-clickable System 7 sound files.

How do I set my Disk Cache correctly?
A. 32K per megabyte of memory in your Mac, unless you have System 7.5.

The Disk Cache is a special feature of your Memory control panel (see Figure 7). It accelerates your Mac by keeping track of the little tasks you do most often — menu commands, folders you open, and so on — and storing them in this special portion of memory that it sets aside.
Trouble is, the more of your Mac’s memory you reserve for the Disk Cache, the less memory is available for your programs. So finding the correct setting is a balancing act, made no easier by the somewhat silly rules you’re about to read. As you read above, the first rule of thumb is to dedicate 32K of memory per megabyte installed in your Mac. If your Mac has 4 megs of RAM, set the cache to 128K and forget it.

The second rule, however, is that there is a bug in the Disk Cache (in Systems before 7.5). If you set the cache higher than 512, you’ll actually slow down your Mac! Therefore, if you run any System earlier than 7.5, no matter how much RAM your Mac has, don’t set the cache higher than 512K.

Fortunately, in System 7.5, Apple created a whole new cache feature that doesn’t include that bug. If you have this (or a later) operating system, there is no 512K limit. Set the Disk Cache as high as you can afford, keeping in mind that doing so eats RAM that your programs could use.

**Can I print a list of what’s on a disk?**

A. You sure can.

Double-click the disk’s icon. Turn the printer on. Choose Print Window from the File menu. That’s it.

**This file is more than 1.4MB. How do I copy it onto a floppy disk?**

A. Compress it, or break it up.

Either way, you’re going to need more software. Various programs, called things like StuffIt, DiskDoubler, and Now Utilities, let you either encode a file into a compressed format, or break it up into smaller chunks. Either technique lets you fit a big file onto floppies. Bear in mind, however, that restoring that file back onto a hard drive requires that same program.

(Of course, I’m assuming you’ve already checked the kind of disk you’re using. The high-density type, marked with a big upside-down HD logo beside the sliding shutter, holds nearly twice as much information as the more common double-density type.)
Chapter 3: America Online & the Internet

My kid cuts off my connection every time she picks up the extension downstairs. What I can do?
A. Buy a Radio Shack Teleprotector, Item #43-107.

It makes all other phone extensions go dead when you are — or your modem is — using the phone.

How can I stop the spinning beachball on America Online?
A. Double-click an AOL text file or mail file.

Sometimes, while waiting for the "host has failed to respond" message, the cursor turns into a spinning beachball that looks like a BMW logo. Pressing Command-period doesn’t stop the beachball, and you can’t to do anything while it’s spinning.

To stop the spinning beachball and regain control of your software, switch back to the desktop, and double-click an AOL text file or mail file that you had previously saved onto your hard drive. If you don’t have one handy, choose New Memo from the File menu, and save the memo onto the desktop. When the beachball starts spinning, click on the desktop to switch to the Finder, then double-click the memo.

Of course, stopping the beachball cursor doesn’t get you where you were trying to go — it doesn’t let you read the message you were trying to open, for example. However, it does return control to you, so you can go do something else until the host feels more responsive.

Whenever I quit AOL, it says I have "information to be sent and/or received." What’s that?
A. Apparently, you haven’t read (or sent) all your e-mail yet. Or you haven’t downloaded the files you marked for future delivery.

Fig. 8: Either you haven’t read or sent your mail, or you haven’t transferred the files you marked for delivery.
Do you see the message shown in Figure 8 every time you try to sign off AOL? It’s a reminder that you have files or e-mail to upload or download, you haven’t read all your incoming mail yet, or haven’t sent all the mail you’ve written offline, or you’ve marked some software for future downloading but haven’t downloaded it yet. Here’s how to clear out all three of these information types:

- **E-mail not yet read**: choose Read New Mail from the Mail menu
- **E-mail not yet sent**: choose Read Outgoing Mail from the Mail menu
- **Software not yet downloaded**: choose Download Manager from the File menu

### What is the Internet?

**A. A network of computer networks.**

The Internet is a network of computers that speak a common language. All of these computers can exchange information — over the world’s telephone wires.

No one person or organization owns the Internet. The networks that compose the Internet are an exotic mix of educational, government, and commercial organizations. The Internet encompasses most of the inhabited globe, and spans a broad spectrum of beliefs, nationalities, languages, politics, and laws.

### What can you do on the Internet?

**A. Exchange e-mail; get files; read public discussions; do research; type in live conversations; and explore the World Wide Web.**

The Internet isn’t One Big Thing. It’s divided into different services (or resources); each requires a different software program. Fortunately, these programs are generally free. You can download them from America Online or the Internet itself (try [http://www.shareware.com](http://www.shareware.com) on the Web).

- **Electronic mail** is the most useful Internet service. You can send e-mail to a friend anywhere in the world for pennies. Your e-mail arrives in minutes. FedEx must hate this stuff. You use a program like Eudora to send and receive e-mail (unless, of course, you’re on America Online or a similar service).

- **File Transfer Protocol (FTP)** means software you can download from FTP sites around the world. For example, Apple’s latest software updates are always posted to an area called ftp.apple.support.com. Fetch is a popular FTP program.
• **Usenet newsgroups** are the Internet equivalent of public bulletin boards. Newsgroups give the Internet its color and sense of community. There are 20,000 newsgroups, on every conceivable topic — the weirder, the better. One popular newsgroup-reading program is NewsWatcher.

• **Gopher** is a menu-based system for retrieving information from databases. Some university libraries have made their card catalogs available through Gopher. (Popular program for accessing them: TurboGopher.)

• The **World Wide Web** integrates text, pictures, sound, and video into convenient, point-and-click pages (screens). Software required: Netscape Navigator or Microsoft Explorer.

• **Internet Relay Chat (IRC)** lets groups of people type messages to each other in real time, like an Internet CB radio. Different *channels* discuss different subjects. Typical software used: GlobalChat.

**How do I get connected?**

**A. The easy way: Sign up for an online service.**

**The macho way: Find an Internet access provider.**

If you’d rather not spend your first weekend of Internet exposure mucking around in technical settings, sign up for America Online. It offers easy, safe access to most Internet features. And for occasional use, an online service ($10 for five hours) is less expensive than a genuine, direct Internet account (example: about $20 per month, flat fee); naturally, if you get addicted to the Net, the flat-fee system is much better.

If the smooth, paved access road of an online service is too sissified for you, you can also subscribe directly to the Internet. This involves finding a local or regional company that’s an *Internet service provider*. In exchange for a monthly fee, this company will provide you with more complete Internet access than the big online services. You provide your own software and knowledge of how to use it. (Easy way to find a service provider and get the Internet programs you need: use the Apple Internet Connection Kit, which makes it all pretty easy.)

Realize, however, that these companies offer no content of their own — no Time magazine, no encyclopedia, no stock quotes, none of the organized, popular features of online services. A direct Internet connection is also, needless to say, harder to use than an online service.
Where do I find all the good Mac programs on the Internet?

A. At sumex-aim.stanford.edu and mac.archive.umich.edu.

If you're on the Internet, I'll assume you know how to find a particular software area (FTP site). Sumex-aim.stanford.edu and mac.archive.umich.edu are the worldwide Internet centers for Macintosh shareware and other files. If you're using the Web, the best Mac-software headquarters is http://www.shareware.com.

How do I use the files posted in newsgroups?

A. It's StuffIt Expander to the rescue.

While it may seem odd to discuss files among newsgroups — which are normally associated only with discussion — some newsgroups do indeed offer files to download. These newsgroups' names contain the word binaries.

To use a file — a picture, sound, or program — from a binaries newsgroup, save the message onto your hard drive. Large files have been split into multiple messages, so make sure you get all of the parts, usually labeled "Part 1/5, Part 2/5," and so on. Now combine the messages into one big text file. You can use copy and paste to combine the parts, but it's easier to use a shareware program like BBEdit Lite (use the Concatenate Files command). Finally, drag the text file onto the StuffIt Expander icon to convert it into a genuine Mac file. (Get StuffIt Expander from an online service or the Internet itself, if you can find it.) Nobody ever said the Internet was easy.

CAQ: Cautiously Asked Question

Who's Craig Shergold, and why should I send him a card?

Craig Shergold, the story goes, is a seven-year-old boy who's dying of cancer. His last wish is to get into the Guinness Book of World Records for having received the most Get Well cards. It's a touching story, and it's true.

Or at least, it was true — a decade ago. Craig had surgery and is in complete remission. He turned 17 in January of 1996. And he did get into the Guinness Book of World Records. Trouble is, the story continues to spread on the Internet, and people keep sending cards. His family receives five sacks of unwanted mail a day.

Then there was the Good Times e-mail virus hoax. And there was the "for every e-mail this computer company receives, they'll make a donation to a cancer charity" hoax.

In other words, the Internet can sometimes be the misinformation superhighway. Remember, nobody runs the Internet; nobody looks over the information that appears there. Don't believe everything you read.
FAQ #24

What’s netiquette?
A. Netiquette means online etiquette — more rules to avoid nasty e-mail from irritated veterans.

Here are three things to avoid:

• DON’T TYPE IN ALL CAPITAL LETTERS LIKE THIS. ALL CAPS IS HARD TO READ AND VERY RUDE. IT’S LIKE SHOUTING IN SOMEONE’S EAR. AREN’T YOU GLAD THIS WHOLE BOOK ISN’T IN ALL CAPS?

• Don’t read, write, or pass on Make Money Fast and other pyramid schemes. These schemes violate federal fraud laws. What’s more, they annoy the heck out of almost everyone. (By the way, the scams don’t work, either.)

• Don’t send unsolicited advertisements. The only newsgroups where you may post advertisements are in the biz.marketplace or for-sale newsgroups. Even then, you should limit the number of groups you post to. Posting the same message to dozens of newsgroups is called spamming, after the Monty Python skit where a group of Vikings drown out conversation by chanting “spam, spam, spam, spam,” etc. Spamming will make a lot of people mad, and can result in the loss of your Internet account.

FAQ #25

What’s a LOL and a :-)?
A. LOL is an abbreviation, and :-) is a smiley face turned sideways.

To save typing online, many people abbreviate expressions like laughing out loud and for what it’s worth: LOL and FWIW. When people want to let you know they’re kidding (or serious), they use little smileys, also known as emoticons. The classic smiley is :-) , which, if you rotate your head 90 degrees to the left, looks like a smiley face.

There are zillions of abbreviations on the Internet, and twice that many smileys. You can buy entire books filled with smileys, but the ones below are all most people need.

<table>
<thead>
<tr>
<th>BTW</th>
<th>HTH</th>
<th>IMHO</th>
<th>IMO</th>
<th>LOL</th>
<th>ROTFL</th>
<th>RTFM</th>
<th>TIA</th>
<th>YMMV</th>
</tr>
</thead>
<tbody>
<tr>
<td>by the way</td>
<td>hope this helps</td>
<td>in my humble opinion</td>
<td>in my opinion</td>
<td>laughing out loud</td>
<td>rolling on the floor laughing</td>
<td>read the f&amp;%*!! manual</td>
<td>thanks in advance</td>
<td>your mileage may vary</td>
</tr>
<tr>
<td>:-)</td>
<td>:-(</td>
<td>:-(</td>
<td>:-(</td>
<td>:-(</td>
<td>:-(</td>
<td>:-(</td>
<td>Smiley</td>
<td>Frowney</td>
</tr>
<tr>
<td>Winkey</td>
<td>Seriously</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
What's .sit, .hqx, etc?

A. Those letters at the end of a file name tell you what kind of file it is.

If you’ve spent much time online, you know that most files are stored in a compressed format so they take less time to download. You also know that there are several different compression formats, with Stufflt being the most common for the Macintosh. You can tell that a file has been compressed with Stufflt — the file’s name ends in .sit.

Hold on to your hat: there are many other compression programs on the Internet. What’s more, some files have been encoded into text. The encoding process converts a typical Macintosh-format data file into a long, gibberish-looking text file that can be transferred through computers that wouldn’t understand a Mac file format. A piece of software that has been thus converted into text is said to have been *binhexed*.

Most of the files at Macintosh FTP sites have been binhexed. If you open a binhexed file in your word processor, you’ll see that it begins with the line “*(This file must be converted with BinHex 4.0).*” There is a program called BinHex 4.0, but it has some bugs. Use the free program called Stufflt Expander instead. You can get it from an FTP site, or very easily from an online service.

In fact, there are many more forms of file compression and text conversion. All you need to know is that Stufflt Expander, along with the accompanying DropStuff with Expander Enhancer, can restore them to normal Mac files. Including any format listed in Table 1.

<table>
<thead>
<tr>
<th>Name suffix</th>
<th>Compression method</th>
</tr>
</thead>
<tbody>
<tr>
<td>.arc</td>
<td>arc</td>
</tr>
<tr>
<td>.zip</td>
<td>PKZip</td>
</tr>
<tr>
<td>.sit</td>
<td>Stufflt</td>
</tr>
<tr>
<td>.cpt</td>
<td>Compact Pro</td>
</tr>
<tr>
<td>.Z</td>
<td>UNIX compress</td>
</tr>
<tr>
<td>.gz</td>
<td>GNU Zip</td>
</tr>
<tr>
<td>.hqx</td>
<td>binhex</td>
</tr>
<tr>
<td>.uu</td>
<td>uuencoded</td>
</tr>
<tr>
<td>.sit</td>
<td>Stufflt</td>
</tr>
<tr>
<td>.cpt</td>
<td>Compact Pro</td>
</tr>
</tbody>
</table>

You may also encounter file-name suffixes that have nothing to do with compression. For instance, horn.wav is a sound in WAV format (a PC format). You’ll learn these things as you go along.
How do I find someone's e-mail address?
A. Call them up.

Believe it or not, the easiest way to find a friend's email address is to pick up the phone. It sure would be nice if there were some kind of up-to-date, electronic, worldwide directory of Internet participants. Trouble is, the Internet's millions of members change hourly — trying to maintain an accurate directory would be a futile task. There are some ways to search for email addresses — there are even entire books, called "Internet White Pages" — but none of them is very good.

What are GIFs and JPEGs, and how do I open them?
A. They're picture formats. Use GIFConverter, GraphicConverter, America Online, or Navigator.

GIF (pronounced like the peanut butter) stands for Graphics Interchange Format. JPEG (pronounced jay-peg) stands for Joint Photographic Experts Group. Both graphics formats are widely used online, because they use compression to reduce downloading time.

If you have America Online 2.5 or higher, you're in luck — the program can open GIFs and JPEGs (just use the Open command in its File menu). Web-browser programs, like Navigator and Explorer, can open these graphics files, too. Otherwise, download GIFConverter or GraphicConverter (shareware graphics programs). Launch the graphics viewer and choose Open from its File menu to open the pictures.
How do I watch TV on a Mac?
A. You need a Mac with video inputs.
The Mac needs a special circuit board inside if it's to double as a TV set. Here are your options:
• a Quadra AV, Centris AV, or Power Mac AV model — or a recent high-end Power Mac, like a 7500, 7600, or 8500
• a Performa/Quadra/LC 630-something, or a 5200-something, with the optional Apple TV card installed
• a Mac TV (remember that model?)
Anyway, once you have your Mac equipped, you also need to figure out some way to bring a TV signal to it. That means connecting it to your cable TV cable, or running a cord from your VCR to the Mac, or using an antenna with the right kind of adapter jack.

Can my Macintosh play CD-ROM discs for a PC?
A. Yes. You may not hear the sound, though.
If you've equipped your Mac with a DOS card (from Apple, Reply, Orange, or another company), you should be in good shape. You can play CD-ROM discs designed to run on PCs only.
If you're running SoftWindows, you may not hear the sound or music, unless you have the most recent version (it has to say, "SoundBlaster compatible"). And if you have neither a DOS card nor SoftWindows, the answer is no: you can't use PC-only CD-ROM discs on your Mac.

I'm pressing the eject button on my Mac, but the CD won't eject!
A. No wonder. You must drag the CD's icon to the trash (onscreen) first.
When I start up my Macintosh, it says that QuickTime could not be installed because it was already installed.

A. You have two copies of the QuickTime extension.

Open your System Folder, open your Extensions folder, and remove one of the copies of QuickTime. (Use the Get Info command on each one to find out how old it is, so you'll be sure that you're throwing away the older one.)

How do I make my Mac talk?

A. Get System 7.5 and install PlainTalk.

System 7.5 comes with something (in your Apple Extras folder) called PlainTalk Text-to-Speech. If you install it, then when you launch SimpleText, a Sound menu appears. Just type something or paste some text, and choose Speak All from the Sound menu. You'll hear the Mac read your text — in a nasal, Norwegian-sounding voice, but unmistakably clear. (You can also make ClarisWorks, America Online, and WordPerfect talk.)

If you have System 7.5 on a CD-ROM, you're in for a real treat. In that SimpleText Sound menu is a Voices submenu that lists 18 different voices. They range from standard male and female to bizarre, bubbly-sounding aliens. (For these options to work, you must first install the PlainTalk software from your CD-ROM, which should put a Voices folder inside your Extensions folder.)
Chapter 5: Troubleshooting & Error Messages

**FAQ #34**

How come the floppy says "0 items," but I can’t copy a 45K file onto it?

A. There's stuff in the Trash.

You may see only one Trash can on your screen. But believe it or not, every disk holds an invisible Trash folder. Even when no icons appear in a disk's window, the disk may actually be full — of stuff in its invisible Trash folder.

To see what's in there, open your Trash can icon. To get rid of the trashed items, of course, empty the Trash. Now you really have 0 items on that floppy.

**FAQ #35**

I've erased this 800K disk twice. It still only has 764K available. What's up with that?

A. You're forgetting about its invisible database.

No 800K disk ever holds 800K, and no 1.4MB disk ever holds 1.4MB. Every disk, even when completely empty, sets aside a few K for its invisible desktop files. These files form a database that keeps track of what files are on the disk, where they're located on the disk's surface, and what their icons look like.

And besides, it's really not such a gyp — if you had a PC instead of a Macintosh, your 800K disks would only hold 720K apiece.

**FAQ #36**

I copied a 2K file onto my hard drive, and it ballooned to 64K!

A. The answer is technical, but mind-blowingly interesting.

Every disk, behind the scenes, is divided up into thousands of little parking places for information called blocks. Every hard drive has exactly the same number of these blocks, no matter what its capacity. Therefore, a 500MB hard drive's little blocks are proportionately larger than a 200MB hard drive's.

It so happens, furthermore, that no file on your disk can take up less space than one block. A teeny-tiny text file that, in reality, is only 1K in size, nonetheless requires a full block's worth of space on your hard drive — which, since a typical hard-drive block is 8K or even 32K, means that several K are wasted.

Now suppose that tiny text file is on a floppy disk whose blocks are 1K
apiece. Naturally, if you copy that file onto a 4,000MB hard drive whose blocks are 64K apiece, you'll see that tiny text file bloat to 64 times its actual size. Fortunately, you can still sleep well, secure in the knowledge that, when copied back onto a floppy, that text file will shrink back to its original 1K size.

SAQ: Stupidly Asked Questions

What's the CPU?

_A true story from a true Apple technician:

Well, this lady came in and told us that she was having problems with her monitor. We suggested that she bring her monitor in, and we promised to check it out.

She brought in the monitor. We plugged it in. It worked without a flaw. We told her that the monitor wasn't the problem — and we asked her to bring in her CPU.

She stared at us blankly. "What's the CPU?", she asked. I explained, "You know, it's the central piece of equipment that all your devices plug into."

I guess I shouldn't have been surprised. She returned an hour later, sure enough, carrying the piece of equipment she plugged everything into.

Her surge suppressor.

And to make this all the more interesting, she was a grade-school computer class instructor.

_Do I need a hard-disk optimizer, whatever that is?_

A. Not unless your hard drive has been 90% full for weeks.

Over time, as you create, edit, and delete files on your drive, things get a little messy behind the scenes. The Mac may split a file into several pieces if one big hunk of space isn't available on the hard drive. (Your drive, to use the geek term, becomes fragmented.)

Of course, that means that your files take longer and longer to open, because the hard drive must look farther and wider to find the pieces. Eventually, if the slowness gets bad enough, some people buy a program called a disk optimizer; its purpose is to re-stack every file on your drive, moving them around and rejoining their pieces. An optimized drive is faster than one with a lot of split-up files.

You'll notice the most dramatic speed difference if your drive has been nearly full for a long time — in other words, if most of your files are split into pieces.

The best-known optimizers are Speed Disk (part of Norton Utilities) and DiskExpress.
**FAQ #38**

When I try to give my hard drive a new icon, I get this message: "This command cannot be completed because it cannot be found."

A. Although this is a technical problem, the solution is easy: use Disk Rejuvenator.

Disk Rejuvenator is free; it's available on America Online or similar services.

**FAQ #39**

How do I turn off that stupid startup test page?

A. The on/off switch is in the LaserWriter Utility program.

Lord knows why laser printer manufacturers design their products to spit out an irrelevant test page every time they're switched on. Anyway, on the disks that came with your Mac, you'll find a little program called LaserWriter Utility or Apple Printer Utility. Launch it. From the Options menu, choose Set Startup Page — and click the Off button.

**FAQ #40**

Every time I open the Chooser, it has forgotten the printer choice I made last time.

A. Just because the correct icon is never highlighted doesn't mean the Chooser forgot.

The Chooser is actually used to choose more than just printers. All kinds of icons might show up there: for file sharing, for your fax/modem, for your scanner, and so on. Because of this arrangement, the Chooser actually remembers several selections at once. That's why no one icon is ever highlighted when you open the Chooser.

**FAQ #41**

Printing takes forever. Can I speed things up?

A. Yes, especially if you're willing to spend some money on it.

If not, you have only two options for speeding up printing.

- Turn off background printing. Do this by opening the Chooser and clicking the Background Printing Off button.

- Make your document less fancy. In particular, using fonts that aren't part built into your laser printer makes printouts take longer, because your Mac must transmit that font information before the printout can begin. The fonts that are built into most laser printers are Times, Helvetica, Helvetica Narrow, Avant Garde, New Century Schoolbook, Courier, Bookman, Palatino, Zapf Chancery, Symbol, and Zapf Dingbats.
If slow printing has annoyed you to the point of opening your checkbook, the rules are simple: the Macintosh and the printer are equally at fault. Upgrading either one — or both — to a faster model will take care of your slow printing headaches.

**Embarrassingly Asked Questions**

**Why won’t this computer turn on?**

*(A true story from a Macintosh technician.)*

I am a service tech.

I received a desperate call from a woman about 75 miles away. Symptom: the Mac was dead — no lights, no display, no ringie-dingie, nada. My first question to this lady was, “Have you verified that it is plugged in to a working power outlet?” She was so insulted, she just about ripped my lungs out over the phone.

I jumped into my van and drove the 75 miles to this customer’s site. As I was getting out of the van, a little voice in my head said, “Leave your tools in the van.” So I did.

When I walked in and saw the setup, I saw the problem immediately. The computer was plugged into one of those multi-adapters that lets you plug in half of your house into a single outlet. It was falling out of the wall, dangling at about a 45-degree angle!

The lady was standing there, breathing fire by this time. I laid my hands on top of the monitor and stated loudly, “If you believe in the Lord Jesus Christ, BE HEALED!” and at the same time, I kicked the plug into the wall while slapping the top of the monitor. Lo and behold, everything went beep, the monitor lit up, and everything was OK. I pulled out my service book, wrote on the ticket “I healed it,” and left.

She never called again.

**Why does my Mac sometimes take so long to start up?**

A. Because it wasn’t shut down normally last time.

All recent Macs perform a lengthy disk-integrity check if they start up after having been shut down improperly. You’ll notice the extra delay between the appearance of the happy Mac icon and the “Welcome to Macintosh” message.
FAQ #43

What’s a “bad f-line instruction”? A. It’s a bad mistake some programmer made.

As your software executes hundreds of computer instructions per second, it may enter an F-line instruction — a direction to consult the math chip, or floating point unit (FPU), attached to your main processor chip. Trouble is, some pre-Power Mac models don’t have an FPU chip. Up pops this message.

But you may as well ignore that explanation; most people encounter the "bad F-line instruction" message on Macs that do have an FPU.

In other words, this message appears most often in error — basically, the Mac lies. Your software may be trying to access a nonexistent memory location, or it may have encountered the letter F in the wrong place in the programmer’s code!

If you’re getting a lot of this message, try re-installing the program you’re using. If that doesn’t work, do a "clean install" of the system software, as described in the actual, 400-page version of this book.

FAQ #44

What says, “Application could not be found.” What gives?

A. You’re double-clicking a document of unknown origin.

Possibility #1: You’re trying to open a memo that was written in ClarisWorks, but you don’t have ClarisWorks. The Mac is letting you know that the program you need to read the file isn’t on hand.

Possibility #2: You do have the program that created the troublesome document, but the Macintosh has gotten muddled in its little head. It happens sometimes. You need to make it re-learn the relationships between your programs and your documents. You do this by “rebuilding the desktop.” (See FAQ #48.)

Possibility #3: You’re double-clicking a text, graphics, or music file that’s so generic that your Mac can’t decide which of your programs to use. Some file formats, such as plain-text files (for typing) and PICT files (for graphics), can be opened by almost any Mac text or graphics program, respectively. These file formats are terrifically useful, because they let you exchange information among programs. In the case of plain text files (also called ASCII files), they even let you exchange information among different kinds of computers, such as Macs and IBM clones. But because the Mac doesn’t associate such generic files with any particular program on your hard drive, you get the “application not found” message.

Fortunately, this third scenario is becoming a thing of the past. Starting with System 7.5, a new control panel called Macintosh Easy Open handles this generic-document problem. When you double-click a generic document, Easy Open shows you a list of every program you own that can open it. You choose which to use to open that mysterious document.
If you don’t have Easy Open, you can still get around this generic-document problem manually. Instead of double-clicking the problem *document* icon, launch the program you want to open it with *first*. Then, from within that program, choose Open from the File menu, and select the mystery document *that* way. Figure 9 should make this clearer.

Figure 9: Top: When you double-click a standard TIFF graphics file, you’ll probably get the “application busy or missing” message. Bottom: One solution is to launch a program that can open it, such as ClarisWorks, and use the Open command. The troublesome file will show up in the list of files.

**Isn’t there a table someplace that tells what all the error messages mean?**

**A. There is now.**

This stuff is, as you’re about to discover, completely unhelpful; it’s designed for programmers to understand (barely), not us. But so many people have requested this information that I’m printing it here as a public service.

There are two categories of error messages. Those with positive numbers are the so-called DS errors (which stands for *deep doo-doo*). These are serious system crashes that require you to restart the machine. Errors with negative numbers aren’t so severe; usually you just have to click an OK button to proceed.

**ID=01:** Bus Error — The Mac has tried to access memory that doesn’t exist — for example, the program you’re using assumed that the Mac has more RAM available that it actually does. The problem is usually that you’re using out-of-date software.

**ID=02:** Address Error — Mac Plus and SE only; your processor chip has tried to access an odd-numbered memory location when it should have accessed an even-numbered one.
ID=03: Illegal Instruction — Your processor has a fixed, specific vocabulary; if the software issues an instruction using lingo your processor doesn’t understand, you get this error message.

ID=04: Zero Divide Error — When programmers test their works in progress, they might deliberately instruct the computer to divide a number by zero, to see how well the program handles errors. Trouble is, they occasionally forget to take this instruction out. You are the lucky beneficiary.

ID=05: Range Check Error — The software checked to see if a number — part of some internal calculation — is within a certain range. It wasn’t.

ID=06: Overflow Error — The Mac allots a certain amount of space for each number it processes. You see this error if a number was too big for the space the software allotted for it.

ID=07: Privilege Violation — For programmers only: your Mac attempted to process a command in User mode instead of Supervisor mode. Bad move.

ID=08: Trace Mode Error — When debugging software, programmers sometimes walk through it, line by line, using something called Trace mode. If you see this message, your processor chip has accidentally switched into Trace mode.

ID=09 and ID=10: Line 1010 & 1111 Trap — Once again, the software has issued an instruction that the processor chip doesn’t understand.

ID=12: Unimplemented Core Routine — As with the ID=04 error, this results from a leftover instruction from the debugging process.

ID=13: Uninstalled Interrupt — An interrupt is a moment during the running of a program when an external device, such as the keyboard or the disk drive, asks for attention. If there aren’t any instructions in RAM that tell the Mac how to talk to that device, you get this error message.

ID=15: Segment Loader Error — To conserve memory, a non-Power Mac program is loaded into RAM in segments as needed. A piece of system software called the segment loader oversees this swapping process. If, for some reason, the segment loader can’t do its thing, this error results.

ID=26–27, 30–31: Missing Packages — A package is a ready-to-run set of system software instructions that handles a particular task, such as initializing a disk. If a package is damaged, one of these messages tells you so. You need to perform a “clean re-install” your system folder.

ID=25: Memory Full Error — You’ve probably run out of memory, although this message may appear erroneously.

ID=26: Bad Program Launch — The Mac couldn’t open the program you tried to launch. Try re-installing it.

ID=20: Stack Ran into Heap. Just as in ID=25, you’ve probably run out of memory, although this message may appear erroneously.
Negative Error Codes
There are many more negative-numbered error messages than positive. Furthermore, they make even less sense to the non-programmer.
(Example: "Packet too large or first entry of the write-data structure didn’t contain the full 14-byte header." Thanks a bunch.)

This table provides the general categories for each number range, along with a few that actually make sense to human beings (such as "bad floppy disk").

Table 2: Negative-numbered errors

<table>
<thead>
<tr>
<th>Error number</th>
<th>What causes it</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 through -8</td>
<td>General system errors</td>
</tr>
<tr>
<td>-9 through -21</td>
<td>Color Manager errors</td>
</tr>
<tr>
<td>-17 through -61</td>
<td>System errors involving files and disks (I/O, or input and output)</td>
</tr>
<tr>
<td>-34</td>
<td>The disk is full</td>
</tr>
<tr>
<td>-35</td>
<td>No such disk, or the Mac can’t find the disk it’s looking for</td>
</tr>
<tr>
<td>-37</td>
<td>Something is wrong with the name of a file (for example, the name includes a colon)</td>
</tr>
<tr>
<td>-39</td>
<td>A corrupted file is on the disk, or the disk is having problems</td>
</tr>
<tr>
<td>-41</td>
<td>The file is too big to fit in memory</td>
</tr>
<tr>
<td>-42</td>
<td>Too many files are open</td>
</tr>
<tr>
<td>-44 and -46</td>
<td>The disk is locked</td>
</tr>
<tr>
<td>-53 through -57</td>
<td>Something’s wrong with the request for a disk</td>
</tr>
<tr>
<td>-60</td>
<td>Something’s wrong with the disk directory</td>
</tr>
<tr>
<td>-64 through -66</td>
<td>Font problems</td>
</tr>
<tr>
<td>-64 through -90</td>
<td>Problems reading disks (timing and track troubles)</td>
</tr>
<tr>
<td>-91 through -99</td>
<td>AppleTalk errors</td>
</tr>
<tr>
<td>-108 through -117</td>
<td>Various memory allocation errors</td>
</tr>
<tr>
<td>-120 through -127</td>
<td>HFS errors (disks, directories)</td>
</tr>
<tr>
<td>-126 through -128</td>
<td>Menu problems</td>
</tr>
<tr>
<td>-130 through -132</td>
<td>More HFS errors</td>
</tr>
<tr>
<td>-147 through -158</td>
<td>Color management problems</td>
</tr>
<tr>
<td>-185 through -199</td>
<td>Resource Manager errors (problems managing data)</td>
</tr>
</tbody>
</table>
"You do not have enough access privileges." Why not?

A. Apple is trying to save your System Folder from disaster.

If you find this child-proofing feature annoying, it's easy to defeat. Open your Control Panels folder. If you see an icon called Performa, double-click it; otherwise, open the one called General Controls.

In either case, you'll see a checkbox called "Protect System folder." Turn it off. Congratulations: you now do have enough access privileges.

Incidentally, there are two less common circumstances in which you might see this warning. The first is if you keep your programs in a folder called Applications; there's also a "protect Applications folder" checkbox in the General Controls panel. When this feature is on, you can't change the Applications folder's contents. Finally, if your Mac is on a network, "access privileges" may refer to permission to examine the hard drives of other people on the network.

My Mac's clock keeps going back to 1904 or 1956.

A. Your Mac's "five-year" lithium backup battery is dying.

You need to contact an Apple technician to replace it.

How come all my icons show up as blank pieces of paper?

A. Probably because your Desktop file is corrupted.

The Desktop file is the invisible database where the Mac stores the icons for all your files — as well as the relationship information (which kind of document gets which icon). If this file gets damaged or confused, as it sometimes does, it gives up on your icons. All document files show up looking like blank pieces of paper, and all programs look like generic diamonds.

Fortunately, slapping the Desktop file back into coherence is simple. The process is called rebuilding the desktop — start the Mac with the Shift key down (until the screen says "Extensions Off"), then immediately press Command and Option until you're asked if you want to rebuild the Desktop file.
I found this "rescued items" folder in my trash. What are they?

A. They're the Mac's attempt to recover from an unfortunate crash.

Some programs, especially Microsoft's, create invisible temporary files on your hard drive — sort of a scratch pad for themselves. Normally, when you quit such a program, it automatically deletes those files. But if you don't quit normally — in other words, if you have a system crash, or you force quit, or you just switch off the Mac without shutting down properly — that program doesn't have a chance to delete its temporary files. The Mac thinks it's doing you a favor: when you restart the next time, it puts those temp files together into that Rescued Items folder. Sometimes you can even recover some unsaved typing by opening one of those temporary files. Otherwise, just empty the trash and forget about it.

Can Word 5 read Word 6 files, and vice-versa?

A. Word 6 reads Word 5 files directly. Word 5 needs the free translator file.

The translator file, called Word 6.0 for Windows & Macintosh, must be placed in the Word Commands folder, in the same folder as Word 5 itself. You can get this translator for free from America Online and other services. (Word 4, Word 5, and Word 5.1 files, by the way, are freely interchangeable.)

Why don't the keys on my number pad work in Microsoft Word?

A. They're supposed to be used for navigating your document.

For example, the 9 and 3 keys scroll up and down one screen, respectively. To switch those keys back to typing numbers, press the Clear key in the upper-left corner of the pad (Word 4 or 5) or Shift-Clear (Word 6). Hit that combination again to switch back to navigation mode.
Is there any way to make my FileMaker database stay sorted?
A. Yes — but there's no easy way.
As you've noticed, FileMaker (and ClarisWorks) databases don't seem to stay sorted after you've sorted them. As soon as you start working with the database, the records seem to be instantly out of order.
The only way to keep your records permanently sorted is to sort them; export them, using the Import/Export command in the File menu; delete all the records from the database; and then re-import the data you exported. Thereafter, you can preserve the sorted order by adding new records in alphabetical order (instead of at the end).

Isn't there any way to change the font permanently for all my ClarisWorks documents?
A. Yes. Create a blank stationery document called ClarisWorks WP Options.
In other words, create a new word processor document. Change the font to something you like. (Change everything else while you're at it — the margins, the line spacing, and so on.) Choose Save from the File menu. In the next window, click the Stationery button. Give your new document the name ClarisWorks WP Options, and save it.
From now on, every time you create a new word processing document, it will have the font you want.

Is it worth buying an extended warranty like AppleCare?
A. No, except maybe for PowerBooks.
You almost never come out ahead, financially speaking, by buying an extended warranty on desktop computer equipment. Even if something does go wrong in, say, five years, the repair cost probably won't be as much as you'd have paid in AppleCare for those five years.
If you carry your PowerBook around a lot, a service plan may make more sense; these are more fragile computers, and they're subject to a lot more abuse.
15% OFF!

Order Macworld Mac FAQs Now For Only $16.99!
(includes 15% discount)

Call mail, or fax your order to us at:

1-800-762-2974
24 hour fax: (800)IDG-2149
7260 Shadeland Station
Indianapolis, IN 46256

Offer valid through December 1996.
Shipping/taxes not included.
Q: What are Mac FAQs?
A: They're the questions that Macintosh users ask every day, fielded expertly by bestselling author David Pogue and organized so you can find answers fast.

Get the most from your Macintosh with Macworld Mac FAQs, the ultimate Macintosh answer book. In the friendly style that made best-sellers of David Pogue's Macs^ For Dummies^ and Macworld Mac & Power Mac SECRETS, this book sheds light on the questions everybody has, but nobody answers, including dealing with Power Macs, System 7.5, Performas, Word 6, and more! You'll find answers from the experts at key vendors' 800 help lines on how to do things, how to buy things, how to fix things, and who to call, Macworld Mac FAQs is like having a personal Mac expert at your side—whenever you need one.

Save time and money when the answers are at your fingertips!

- How do you do it? — Mailing labels, automatic backups, Mac phone answering...
- Do you need it? — Performa vs. regular Macs, CD-ROM, System 7.5...
- What happened? — Blank icons, error messages, balking fax modems...
- What is it? — FPU chips, IDE drives, AppleScript...
- Are you doing this right? — Hard-disk partitioning, word processing shortcuts, optimal control-panel settings...
- What's the deal? — What your serial number means, secrets of the magazine reviews, what became of John Sculley...
- Plus, find the top 10 questions Mac users have about Windows... and how to work Windows in a pinch

Find it quickly! The super-index inside answers questions and gets solutions fast, so you can get on with your work!